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NEW QUESTION 1

You have a table that contains data relating to exam candidates and their associated scores.

You need to visualize the exam data by separating the data into quartiles. The visualization must display the mean score and must identify any outliers.
Which type of chart should you use?

A. line

B. histogram

C. pie

D. box and whisker

Answer: D
Explanation:

https://support.office.com/en-us/article/create-a-box-and-whisker-chart-62f4219f-db4b-4754-aca8-4743f6190f0

NEW QUESTION 2
You have a table in a Microsoft SQL Server database that has more than 5 columns. A sample of the data and some of the columns are shown in the following
table.
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The table contains more than two million rows. You have 100 clients and 10 products.
You need to load the data to Excel. The solution must minimize the amount of memory used by the model. What should you do?

A. Move the database to a Microsoft Azure SQL databas

B. Load the table to the data model.

C. Load the data to the data model as three tables named Clients, Orders, and Product
D. Ensure that each table has only the relevant column

E. Remove duplicate rows from Clients and Products.

F. Load the data to one worksheet.

G. Load the data to three worksheets named Clients, Orders, and Product

H. Ensure that each worksheet has only the relevant column

I. Remove duplicate rows from Clients and Products.

Answer: B

NEW QUESTION 3

You use a workbook query to import a table named Customers that contains a column named CustomerName. CustomerName has names in the format of
Lastname, Firstname.

You need the CustomerName column to contain names in the format of Firstname Lastname. A space must separate Firsthname and Lastname.

Which two commands should you use? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.

NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

© Split Column By Delimiter

© Merge Columns

https://support.office.com/en-us/article/split-a-column-of-text-power-query-5282d425-6dd 0-46ca-95bf-8e0da9539662
https://support.office.com/en-us/article/merge-columns-power-query-80ec9ele-1eb6-4048-b500-d5d42d9f0

NEW QUESTION 4

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a query named Queryl that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.
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UserName Userld Location
Userl 1001 nuil
Liser] 1001 | Seattle
Userd 1002 il
Lisar? 1002 | Ssaltle
Userd 1003 | Meontreal
Lisard 1004 null

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

UserMName Userld Location
serl 1001 Seatile
Userz 1002 Seattle
Lgerd 1003 hontreal
sard 1004 nuill
Usars 1005 il

Solution: You select the UserName and Location columns, and then you click Keep Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 5

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, white others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a query named Query1l that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved t]y the query is shown in the following table.

UserMame Userld Location
Userl 1001 null
Userl 1001 | Seattle
Users 1002 il
User2 1002 | Seattle
User3 1003 | Montreal
Userd 1004 null

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

UserName Userld Location
Userl 1001 Seattle
User2 1002 Seattle
User3 1003 Maontreal
Userd 1004 nedl
Userk 1005 nwl

Solution: You select the-UserName and Location columns, and then you click Remove Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 6
You need to create a PivotChart as shown in the exhibit. (Click the Exhibit button.) Exhibit:

Which field should you use for each area? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A
Explanation:

Legend: BrandName Axis: MonthName

NEW QUESTION 7

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, white others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have a query named Quetyl that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.

UserName Userld Location
Userl 1001 Al
Userl 1001 | Seattle g
User? 1002 !
User2 1002 | Seattle
zerd 1003 | Montreal
Userd 1004 null

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

UserName | Userld Location |
Userl 1001 Seattle :
User2 1002 Seattle p
User3 | 1003 Montreal® |
Userd 1004 null |
User5 | 1005 | nutl |

Solution: You sort the UserName column in ascending order. You select the UserName column, and then you click Remove Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 8
You have a workbook query that loads data from C:\Data\Users.xlIsx. You move Users.xlIsx to a shared folder on the network.
You need to ensure that you can refresh the data from Users.xIsx. What should you do?

A. From the Linked Table tab in Power Pivot, modify the Update Mode.

B. From Query Editor, modify the Source step.

C. From the Insert tab in Excel, click My Add-ins, and then manage the add-ins.

D. From the Data tab in Excel click Connections, and then modify the properties of the connection.

Answer: D

NEW QUESTION 9

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.

Your company has sales offices in several cities.

You create a table that represents the amount of sales in each city by month as shown in the exhibit.
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You need to ensure that all values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You modify the conditional formatting rule, and then set a new value for the yellow icon. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 10

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You have the following data.

Ao T

Solution: Open the Advanced Filter dialog box, select Filter the list, in-place, and then select Unique records only.
Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 10

You are building a KPI.

You need to configure the KPI to display a red icon when the sales from a month is less than nine percent of the sales from the last 12 months.
What should you use to define the target value?

A. an absolute value
B. a calculated column
C. a calculated field

D. a measure

Answer: A

Explanation:
https://msdn.microsoft.com/en-us/library/hh272049(v=sql.110).aspx

NEW QUESTION 13

You have an Excel workbook query that loads data to a worksheet and the data model. You need to ensure that the data is refreshed whenever you open the
workbook.

What should you do?

A. From the File tab, click Option, and then modify the Data option.

B. From the File tab, click Options, and then modify the General options.

C. From the Data tab, click Queries & Connections, and then edit the properties of the query.
D. From the Power Pivot model, modify the Table Behavior setting.

Answer: C

Explanation:
https://support.office.com/en-us/article/refresh-an-external-data-connection-in-excel-2016-for-windows-152417

NEW QUESTION 14

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.

You have an Excel workbook that contains a table named Tablel. A sample of the data in Tablel is shown in the following table.
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Solution: You create a hierarchy named Products that contains ProductCategory,

Solution: You create a measure named Products the uses the DataTable DAX Function. You add a PivotTable. You drag products to the Rows field. You drag
Price to the Values field.

Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 17
You need to configure a PivotChart as shown in the following exhibit.

Witch chart element should you enable?
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A. Data Labels
B. Axis Titles
C. Data Table
D. Error Bars

Answer: B

NEW QUESTION 19
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)

Data Sample exhibit:
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:

c DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue column.

c Workshops have a list of all the workshops and the current and previous workshop managers. The

format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the
record is the current workshop manager.

c RepairTypes has a list of all the repair types

© Dates has a list of dates from 2015 to 2018

End of repeated scenario.

You need to add a custom column to the workbook query for Workshops that contains the email address of the workshop manager. The format of the email
address is firstname.lasthame@contoso.com.

How should you complete the query from Query Editor? To answer, select the appropriate options in the answer area.

I}IOITE: Each correct selection is worth one point.

- Answer Area
AR TR tverkshop manegery. 7y =i
\ Tt et
j he Text Heplace
| Tt St
Trac. Sart
A. Mastered

B. Not Mastered
Answer: A

Explanation:
Text.Replace([Workshop Manager],” ",".")&Contoso.com
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NEW QUESTION 21
You have the following data sample.

OrderDate OrderQuantity UnitPrice SalesAmount
7/3/2017 3 12.00 36.00
7/3/2017 2 19.99 28.00
7/3/2017 2 22.00 44.00
7/4/2017 1 29.99 29.00
7/4/2017 2 31.99 62.00
7/3/2017 1 38.00 38.00

You need to create a PivotTable that presents the data as shown in the following table.

Unit Price Range Sum of Sales Amount
10-20 54.00
20-30 73.00
30-40 100,00

A. Create a PivotTabl

B. Add UnitPrice to the Rows area and add SalesAmount to the Values area.Right-click a cell value for UnitPrice and modify the Group settings.

C. Create a PivotTabl

D. Add SalesAmount to the Rows area and add UnitPrice to the Values area.Right-click a cell value for SalesAmount and modify the Group settings.
E. Create a PivotTabl

F. Add UnitPrice to the Rows area and add SalesAmount to the Values area.Right-click a cell value for SalesAmount and modify the Field Settings.
G. Create a PivotTabl

H. Add SalesAmount to the Rows area and add UnitPrice to the Values area.Right-click a cell value for UnitPrice and modify the Field Settings.

Answer: A

NEW QUESTION 24
You have a model that contains data relating to corporate profits. The model contains a measure named Profit.

You need to create a PivotTable to display the Profit measure in three different formats by using the Show Value As feature. The PivotTable must produce the
results shown in the following table.

How should you configure the Show Value As feature for % Profit of Annual Total and % profit of Grand Total? To answer, select the appropriate options in the
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answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

% Profit of Annual Total: % of Parent Total

% Profit of Grand Total: % of Column Total

https://support.office.com/en-us/article/show-different-calculations-in-pivottable-value-f ields-014d2777-baaf-480b-a32b-98431f48bfec

NEW QUESTION 28

You have an Excel workbook that displays two PivotCharts. One chart displays sales by month. The other chart displays sales by year.

You add a slicer for month.

You discover that when you select a month in the slicer, the data in the sales by year PivotChart changes. You need to prevent the slicer from affecting the sales
by year PivotChart.

What should you do?

A. Remove all the fields from the Filters area of the sales by month PivotChart.
B. Maodify the Value Field Settings for the values of the sales by year PivotChart,
C. Modify the Report Connections of the slicer.

D. Remove all the fields from the Filters area of the sales by year PivotChart.

Answer: C

NEW QUESTION 30
You need to create a combo chart to display the count of orders by month and profit by month as shown in the exhibit. (Click the Exhibit tab.)

How should you configure the combo chart? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A
Explanation:

Order Count:Stacked columnNo Profit:LineYes
http://www.excel-easy.com/examples/combination-chart.html

Insert Chart 7 x
Recommended Charts Al Charts
¥ Recent i . | A |
B Templates EHJ:‘H LEEE m ﬁ%
i Column -
|24 Line Custom Combination
Fia .

3 Chart Title
B Bar 14000 16000
E Area ] 18000
[ %Y (Scatter) 100 12000

G 16000
i Stock Ea00

7 OO0 g
@J Surface E000
}ji:' Radar o 4000
BE Treemap o i

o 0
@ Sunburst fan Feb Mar Apr May Jun  Jul Aug Sep O rav  Dec
il Histogram — e = Profit
Bit Box & Whisker | croocethe chart type and axis for your data series:
[ waterfall Series Mame Chart Type Secondary Axis|
ﬁ of } | I Crders Stacked Cokurmn E
B erofi Line ~ [
oK Cancel

NEW QUESTION 33
You have the PivotTable shown in the following exhibit.
gl 111

You need to display only rows in the PivotTable in which the sum of LineTotal is greater than 100. What should you do?

A. From Row Label, configure a Label filter.

B. Add a slicer for LineTotal and select the values from the slicer.
C. From Row Label, configure a Value Filter.

D. Add LineTotal to the Filters area of PivotTable Field

E. Configure the Filters value.

Answer: B

NEW QUESTION 34

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
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Data Sample exhibit:

The tables in the model contain the following data:

c DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue column.

c Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always
Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.

© RepairTypes has a list of all the repair types

© Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You need to create a PivotChart that displays the month, the hours of the month, and the hours of the previous month, as shown in the following exhibit.

Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the appropriate fields to the correct targets. Each value may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A
Explanation:

IF (ISBLANK[(Total Hours]),BLANK(), CALCULATE([total Hours], DATEADD(tblDates(Date),
-1,MONTH)))

NEW QUESTION 37
You have a workbook query that loads data from a table named Products. Products contains a column named IntemalPrice that has a Data Type of Decimal.

The Leader of IT Certification visit - https://www.certleader.com



Cel’[Leadel” 100% Valid and Newest Version 70-779 Questions & Answers shared by Certleader

Toader of IT Corlifications https://www.certleader.com/70-779-dumps.html (117 Q&As)

From Query Editor you create a custom column named ResellerPrice that uses a formula to multiply InternalPrice by 1.2, and then you remove the IntemalPrice
column.
What will occur when you load the data to a worksheet?

A. All the columns except InternalPrice will load to the worksheet The values in ResellerPrice will be correct.

B. An error message will appear and all the data will fail to load.

C. An error message will appear and all the columns except InternalPnce and ResellerPrice will load to the worksheet.
D. All the columns except InternalPrice will load to the workshee

E. The values in ResellerPrice will be null.

Answer: D

NEW QUESTION 42
You have the data model shown in the exhibit.
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You need to create a hierarchy from D|mProductSubcategory[ProduaSubcategoryName]andDlmProduct[ProductName]
What should you do before you create the hierarchy?

A. Create a relationship between the table

B. To DimProductSubcategory, add a calculated column named ProductName that uses the
LOOKUPVALUE(DimProduct[ProductName],DimProduct[ProductKey],[ProductKey]) DAX formula.

C. To DimProduct, add a calculated column named ProductSubcategoryName that uses the LOOKUPVALUE(DimProductSubcategory
[ProductSubcategoryName],DimProductSubcategory[ProductCategoryKey],[ProductSubcategoryKey]) DAX formula.

D. Create a relationship between the table

E. To DimProduct, add a calculated column named ProductSubcategoryName that uses the RELATEDTABLE
(DimProductSubcategory[ProductSubcategoryName]) DAX formula.

F. To DimProduct, add a calculated column named ProductSubcategoryName that uses the VALUES(DimProductSubcategory[ProductSubcategoryName]) DAX
formula.

Answer: B
NEW QUESTION 46

Your company has sales offices in several cities.
You create a table that represents the amount of sales in each city by month as shown in the exhibit.

You need to ensure that all values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You create a measure, and then define a target value. Does this meet the goal?

Answer: B

NEW QUESTION 51
You have the following table.
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What should you do?

A. Add Product to the Rows are

B. Add LineTotal to the Values area twice.
C. Add LineTotal to the Rows are

D. Add Product to the Values area twice.

E. Add Product to the Rows are

F. Add LineTotal to the Columns area twice.
G. Add LineTotal to the Rows are

H. Add Product to the Values area twice.

Answer: B

NEW QUESTION 54

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.

You have an Excel workbook that contains a table named Tablel. A sample of the data in Tablel is shown in the following table.

— ——— Ts
[ € ] I

You need to create a PivotTable in PowerPivot as shown in the exhibit.
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AR EELTRR

Solution: You create a hierarchy named Products that contains ProductCategory, ProductSubCategory, and ProductName. You add a PivotTable. You drag
Products to the Rows field. You drag Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: A
Explanation:

Hierarchy Products that contains ProductCategory, ProductSubCategory, and ProductName
https://www.tutorialspoint.com/excel_power_pivot/excel_power_pivot_hierarchies.htm

NEW QUESTION 59
You create a new workbook and add a table to a data model. The data is shown in the following table.

You need to create a visualization as shown in the following exhibit.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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- Angwer Area

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Create a Pivot Table. Create a measure.
Create a Power View Report

NEW QUESTION 62

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario

You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded
to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

Question H Exhibit d

T DimivoductSabcategony
™ ProduttSubiategonykiey
M productsubeategorytabel
[ Pioductsubategoryhiame
7 ProductsubcategonyDesaiption
I ProductCategonykry
7 TiloadiD
M loadDate

Your company has 100 products subcategories and more than 10,000 products. End of repeated scenario.
You need to create a chart as shown in the following exhibit.
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Which field should you use for each area? To answer, drag the appropriate field to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Axis: Month Year Legend: Channel Name Values: SalesAmount

NEW QUESTION 64

You have a measure named SalesGrowth that calculates the percent of sales growth. The measure uses the following formula.

([Total Sales Current Year] - [Total Sales Last Year]) / [Total Sales Last Year]

Total Sales Current Year is a measure that calculates the sales from the current calendar year. Total Sales Last Year is a measure that calculates the sales from
the previous calendar year.

You need to create a KPI that displays a red icon when the sales growth is less than last year. What should you use to define the target value?

A. an absolute value of 0

B. the Total Sales Current Year measure
C. an absolute value of 100

D. the Total Sales Last Year measure

Answer: D

NEW QUESTION 69

You add two tables named Date and Invoices to a data model, Invoices contains a column named InvoiceDate that has a Data Type of Date, Date contains a
column named DatelD that has a Data Type of which Number. DatelD is in the format of YYYYMMDD.

You need to create a relationship between Date and Invoices. What should you do first?

A. Change the Data Type of InvoiceDate and DatelD to Text.

B. Create a measure in Invoices that uses the Format DAX Function.

C. Change the Data Type of DatelD to Date.

D. Create a calculated column in Invoices that uses the Format DAX function.
Answer: C

Explanation:

https://support.office.com/en-us/article/data-types-in-data-models-e2388f62-6122-4e2b-bcad-053e3da9ba90?ui=

NEW QUESTION 72
You have a query that retrieves the following data.
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Vendor ID Quantity
110 10

110 10

110 5

110 3

111 3

111 2

111 3

112 1

112 1

113 10

You need to configure the query to ensure that the data appears as shown in the following table.

Vendor ID Quantity
110 30

111 8

112 2

113 10

What should you do?

A. From the Transform tab, use the sum function on the Vendor_ID column
B. Group by Vendor_ID and add a SUM aggregation

C. Unpivot the table on the Vendor_ID column

D. Pivot the table on the Vendor_ID column

Answer: B

NEW QUESTION 75
You have a workbook query that loads the following table

.
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You pivot the table on the Key column by using Value as the values column, and you receive the results shown in the following table.

You need to ensure that the data appears as shown in the following table.

T T

What should you do?

A. Change the aggregate value function of the pivot.

B. Select the ID column, and then click Unpivot Columns
C. Change the Data Type of the Value column.

D. Delete the Picoted Column ste

E. Select the Key column, and the click UnpivotColumns.

Answer: B

Explanation:
References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9eal-49¢1-9d95-f588221¢7098

NEW QUESTION 79
You have a PivotChart template named Templatel. You add a PivotChart to a worksheet.
You need to apply the template to the PivotChart. What should you do?

A. On the Design tab, click Change Chart Type.
B. On the Format tab, click Format Selection.
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C. Right-click the chart and then click PivotChart Options.
D. Right-click the chart and then click Format Chart Area.

Answer: A

Explanation:
© Click the chart

© On the Charts tab, under Change Chart Type, click Other, and then under Templates, click the chart template that you created.
https://stackoverflow.com/questions/17386777/how-to-apply-a-saved-chart-template-to-an-existing-chart

NEW QUESTION 82

You create an Excel workbook named SalesResults.xIsx. You create a workbook query that connects to a Microsoft SQL Server Database and loads data to the
data model. You create a PivotTable and PivotChart.

You plane to share SalesResults.slsx to several users outside of your organization.

You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.

What should you do?

A. Modify the source of the query.

B. From Query Editor, open the Data Source Setting and delete the credentials.
C. Run the Document inspector.

D. Save the workbook as an Excel Binary Workbook (xIsx)

Answer: A
Explanation:

References:
https://support.office.com/en-us/article/data-source-settings-power-query-9f24a631-f7eb-4729-88dd-6a4921380

NEW QUESTION 85

Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario

You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.
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The data model is shown in the Data Model exhibit.

The tables in the model contain the following data:

DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue are two measures defined in DailyRepairs. Total Hours sums the Hours column, and Total
Revenue sums the Revenue column.

Workshops has a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always Firsthame
Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.

RepairTypes has a list of alt the repair types. Dates has a list of dates from 2015 to 2018. End of repeated scenario.

You create a measure named Average Revenue Per Hour that calculates the average revenue per hour.

You need to populate a cell in a worksheet to display the Average Revenue Per Hour where Repair Type is Engine.

Which Excel formula should you use?
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A. Option A
B. Option B
C. Option C
D. Option D

Answer: D

NEW QUESTION 88
You have two queries named Client and Invoices. A sample of Client is shown in the following table.

A sample of Invoices is shown in the following table.

You need to create a new table that has the following information.

Which join kind should you use?

A. Inner

B. Left Outer
C. Right Anti
D. Left Anti

Answer: B
Explanation:

https://www.excelguru.ca/blog/2015/12/16/merge-tables-using-outer-joins-in-power-query/

NEW QUESTION 90
You have a query that retrieves customers and their locations. You have a sample of the data as shown in the following table.

Additional customers and locations are added frequently.
You need to transform the data as shown in the following table.
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A. Select the Locations columns and then select Split Column by Delimite
B. Use a comma as the delimiter and split into rows.

C. Select the Locations columns and then select Split Column by Delimite
D. Use a comma as the delimiter and split into columns.

E. Select the Customer columns, and then click Unpivot Columns.

F. Select the Customer columns, and then click Unpivot Other Columns.

Answer: A

NEW QUESTION 91
You have a table named Sales that has three columns named Region, Country, and SalesAmount. You create a PivotTable as shown in the following exhibit.

You need to ensure that the PivotTable appears in three columns as shown in the following exhibit.

What should you do?

A. On the Design tab, click Report Layout and then click Show in Compact Form.
B. Move Country from the Rows area to the Columns area.

C. Move Country from the Rows area to the Values area.

D. On the Design tab, click Report Layout and then click Show in Tabular Form.

Answer: D

NEW QUESTION 95

You have a data model that contains a table named SalesOrders has four columns named Orderld, SalesAmount, OrderDate, and Territory.

You plan to create a PivotChart that will display the percentage of SalesAmount for each Territory. You need to create a measure to calculate the percentage of
sales of each territory.

How should you complete the DAX formula? To answer, drag the appropriate value to the correct targets. Each value may be used once, more than once, or not at

A. Mastered
B. Not Mastered

Answer: A

Explanation:
SUM([SalesAmount) / ALL(SalesOrders) /(FILTER , ALL(SalesOrders))

NEW QUESTION 96
You have an Excel spreadsheet that contains a PivotChart. You install Microsoft Power Bl Publisher for Excel.
You need to add a tile for the PivotChart to a Power Bl dashboard. What should you do?

A. From the Power Bl tab in Excel, click Pin.

B. From the File menu in Excel, click Publish.

C. From powerbi.com, upload the excel workbook.
D. From powerbi.com, click Get apps.
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Answer: A

NEW QUESTION 98
You have a date column named [Date] in the format of mm-dd-yyyy.
You need to create a column named Quarter that displays the yearly quarter. A sample of the desired data is shown in the following table.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

MONTH3

="Qtr " & ROUNDUP(MONTH([Date])/3,0)

="Qtr " & ROUNDUP(MONTH([Date])/3,0)
http://www.decisivedata.net/blog/quickly-create-week-month-quarter-and-year-fields-from-a-date-using-dax

NEW QUESTION 102
You have a model that contains data relating to corporate profits. The model contains a measure named Profit.

You need to create a PivotTable to display the Profit measure in three different formats by using the Show Value As feature. The PivotTabte must produce the
results shown in the following table.

How should you configure the Show Value As feature for % Profit of Annual Total and % Profit of Grand Total? To answer, select the appropriate options in the
answer area.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

% Profit of Annual Total: % of Parent Total

% Profit of Grand Total: % of Column Total
https://support.office.com/en-us/article/show-different-calculations-in-pivottable-value-fields-014d2777-ba

NEW QUESTION 106

Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.

Start of repeated scenario.

You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the exhibit. (Click the Exhibit button.)

Exhibit:

Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You need to cr.eate a chart as shown in the foIIowmg exh|b|t
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Which type of chart should you use?

A. Line with markers
B. clustered column
C. stacked column
D. combo

Answer: D
Explanation:

https://support.office.com/en-us/article/available-chart-types-in-office-a6187218-807e-4103-9e0a-27cdb19afb90

NEW QUESTION 109
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
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stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions
will not appear in the review screen. You have the following data.

3 -
Fi= o,

You need to retrieve a list of the unique ProductName entries.
Solution: Create a PivotTable that uses the ProductName field in the Values area. Does this meet the goal?

Answer: B

NEW QUESTION 111
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